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安全性未審査の組換え DNA 技術応用食品の検査方法の一部改正について 

 

 

安全性未審査の組換え DNA 技術応用食品の検査方法については、「安全性未

審査の組換え DNA 技術応用食品の検査方法について」（平成 24 年 11 月 16 日付

け食安発 1116 第３号厚生労働省医薬食品局食品安全部長通知）により通知して

いるところです。 

今般、国立医薬品食品衛生研究所における検討を踏まえ、当該通知の別添「安

全性未審査の組換え DNA 技術応用食品の検査方法」について、「遺伝子組換え

さけ（AquAdvantage）」の検体採取及び検査方法を新たに定め、別紙のとおり改

正しましたので、その取扱いに遺漏のないようお願いします。 

 

 

 

 

 

 

 

 

【照会先】 

厚生労働省 医薬・生活衛生局 

食品監視安全課 化学物質係 

TEL：03(5253)1111 (内線 4242) 

FAX：03(3503)7964 



（参考） 

（別添） 

 

 

 

 

 

 

 

 

 

 

 

安全性未審査の組換え DNA 技術応用食品の検査方法 
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Ⅰ．検体採取方法 
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1. 亜麻、コムギ、コメ、トウモロコシ、ナタネの検体採取 
1.1. 亜麻、コムギ、コメ、トウモロコシ、ナタネの穀粒の検体採取 
 
組換えDNA技術応用食品が不均一に分布しているということを前提として、ロットを代

表するような検体採取を行うため、対象となるロットの大きさ、荷姿、包装形態に応じて、

以下に掲げる検体採取を行う。検体採取に際しては、他ロットの穀粒が混入しないよう十

分配慮し、使用する器具・容器包装等は使い捨てのものを使用するか、その都度、十分に

洗浄等を行い使用する。 
次に、検体採取した穀粒が均質になるよう十分に混合した後、この中から検査に必要な

一定量を採り、粉砕器等を用いて均質に粉砕する。 
ナタネの穀粒に関しては、1 検体（検体採取量 1 kg）のうち500 gを粉砕して用いる。残り

の500 gは穀粒の状態で保管する。粒検査の時にはこれを用いる。 
 
 
1.1.1. 袋又はカートン積みの場合 
 
以下の表に従って検体採取を行う。 

ロットの大きさ 検体採取のための開梱数 検体採取量（kg） 検体数 

 ≦ 15  2 1 1 
16 ～ 25  3 1 1 
26 ～ 90  5 1 1 
91 ～ 150  8 1 1 

151 ～ 280  13 1 1 
281 ～ 500  20 1 1 
501 ～ 1,200  32 1 1 

1,201 ～ 3,200  50 1 1 
3,201 ～ 10,000  80 1 1 

10,001 ～ 35,000  125 1 1 
35,001 ～ 150,000  200 1 1 

150,001 ～ 500,000  315 1 1 
 ≧ 500,001  500 1 1 

 
 
1.1.2. ばら積みの場合 
1.1.2.1. サイロ搬入時 
 
サイロに搬入する際に 1 サイロを 1 ロットとして、ロット全体を代表する検体となるよ

うオートサンプラー等を用いて検体採取を行うものとし、適正な時間的間隔をもって15 回、

計10 kg以上を検体採取したものを縮分してサイロ毎に1 検体（1 kg以上）とする。 
既にサイロに搬入したものについては、他のサイロに移動させる時点で同様に検体採取

を行う。 
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1.1.2.2. はしけ搬入時 
 
はしけ（内航船を含む。）に搬入する際に 1 はしけを 1 ロットとして、ロット全体を代

表する検体となるようオートサンプラー等を用いて検体採取を行うものとし、適正な時間

的間隔をもって 15 回計 10 kg 以上を検体採取したものを縮分してはしけ毎に 1 検体（1 kg
以上）とする。 
 
1.1.2.3. はしけにおける検体採取 
 
すでにはしけに搬入したものについて検体採取を行う場合、 1 はしけを1 ロットとして、

ロット全体を代表する検体となるよう上層、中層、下層毎に各5カ所、計15カ所から、 
計10 kg以上を検体採取したものを縮分してはしけ毎に1 検体（1 kg以上）とする。 
 
1.1.2.4. コンテナにおける検体採取 
 

1コンテナを1ロットとして、ロット全体を代表する検体となるよう上層、中層、下層毎

に各5カ所、計15カ所から、計10 kg以上を採取したものを縮分してコンテナ毎に1検体（1 kg
以上）とする。 
 

 
1.2. 加工食品の検体採取 
 
加工食品の検体採取については、対象となるロットの大きさに応じて以下の表に従い検体

採取を行う。 
 
 

1.2.1. トウモロコシの粉砕加工品（コーングリッツ、コーンフラワー、コーンミール等、

穀粒を粉砕したもの） 
 
検体採取については、1.1.1.の袋又はカートン積みの場合に従う。 

 
 
1.2.2. それ以外の加工食品 
 
以下の表に従って検体採取を行う。 

ロットの大きさ 検体採取のための開梱数 検体採取量（g） 検体数 

 ≦ 15  2 120 1 
16 ～ 50  3 120 1 
51 ～ 150  5 120 1 

151 ～ 500  8 120 1 
501 ～ 3,200  13 120 1 
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3,201 ～ 35,000  20 120 1 
35,001 ～ 500,000  32 120 1 

 ≧ 500,001  50 120 1 
 
 

1.3. コムギの粉砕加工品の検体採取（小麦粉等、穀粒を粉砕したもの） 
 
 検体採取については、1.1.1.の袋積みの場合に従う。 
 
 
2. パパイヤ及び、ばれいしょ及びさけの検体採取 
2.1. 生鮮のパパイヤ及び、生鮮のばれいしょ及び生さけの検体採取 
 
生鮮のパパイヤ及び、生鮮のばれいしょ及び生さけの検体採取については、対象となる

ロットの大きさに応じて以下の表に従い検体採取を行う。 
ロットの大きさ 検体採取のための開梱数 検体採取量（個） 

 ≦ 50  2 2 
51 ～ 500  3 3 

501 ～ 35,000  5 5 
 ≧ 35,001  8 8 

 
 
2.2. パパイヤ及び、ばれいしょ及びさけの加工食品の検体採取 
 
パパイヤ及び、ばれいしょ及びさけの加工食品の検体採取については、対象となるロッ

トの大きさに応じて 1.2.2.の表に従い検体採取を行う。なお、果汁・飲料製品、氷菓等製

品については、検体採取量を 480 g とする。また、パパイヤ又は、ばれいしょ又はさけの

含有量が少ない加工品について実施する場合は、製品分類ごとに複数回の前処理試行が可

能となるよう適宜検体採取量を増やして採取すること。 
 

 

検査原則 

当検査は、生鮮及び種々の加工食品が検査対象検体として想定されるため、その性状に

より測定結果は変動する。これらを縮小するための原則について記す。  

・ 検査対象検体は、一検体数を一単位とする。  

・ 原則として、検査対象検体の食さない部分を廃棄した可食部を試料とする。（例えば、生鮮のパ

パイヤについては種子・果皮を除いた果肉部分、ばれいしょについては皮を除いた塊茎部分、

さけについては鱗を除いた皮や筋肉などのさけの細胞を十分に含む部分） 

・ 試料中の成分は、不均一に分布すると考えられるため、検査に供する前に試料全量を粉

砕器等*で十分に破砕し、均質混和して調製試料とする。  
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・ 検査に供する調製試料は固体や液体の性状に関わらず、重量測定にて一定量を採取する。  

・ 試料調製を含む検査全般は、空気の動きがなく温度・湿度の変動が少ない区切られた空

間で行い、コンタミネーションを防ぐよう実施する。  

・ 微量測定のため、粉砕用器具*容器、秤量用器具、凍結乾燥瓶は中性洗剤等で洗浄後、ア

ルカリ洗剤に一晩浸け置きする。あるいは超音波洗浄機を用い、30分間の超音波処理を

行う。洗浄後は、DNA Zap solution（Thermo Fisher Scientific社製）などを使用し器具・容

器に付着したDNAを分解し、改めてよく洗浄した後に、実験に使用することを薦める。  

 
* レッチェGM200（レッチェ社製）、ミルサー（イワタニ社製）、Force Mill（大阪ケミカル社製）、

Xtreame Blender（Waring社製）、磁製乳鉢・乳棒および同等の結果が得られるものを用いる。 

 
 
3. その他 
 市販の亜麻、コメ、ナタネに関しては、検体採取量は検査を繰り返し行うのに十分の量と

する。  
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Ⅱ．個別検査方法 
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亜麻（FP967）の検査方法（略） 
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コムギ（MON71800）の検査方法 
 
 
コムギ穀粒又は粉砕加工品を検査対象として、DNA 抽出精製はシリカゲル膜タイプキ

ット法（DNeasy Plant Maxi Kit, QIAGEN）を用い、1検体から2併行でDNAを抽出精製する。

得られた各DNA試料液を用いて、2ウェル並行で定性リアルタイムPCRを実施する。 
 
 
1.～2.（略） 

 
 

3. 結果の解析と判定（図1参照） 
 
MON71800検知試験およびコムギ陽性対照試験のいずれについても、結果の判定は

Amplification plot上で指数関数的な増幅曲線とCt値の確認、及びmulticomponent上での対象

蛍光色素由来の蛍光強度（FAM）の指数関数的な明確な増加の確認をもって行う。まず、

MON71800検知試験において目視でAmplification plot上に指数関数的な増幅曲線が確認さ

れた場合には、MON71800陽性を疑う。次いで、ベースラインを3サイクルから15サイクル

で設定し、ΔRnのノイズ幅の最大値の上側で、安定した指数関数的な増幅曲線上で交わる

Threshold line（Th. line）として0.2に設定する。ただし、Th. lineがノイズや指数関数的でな

い増幅曲線と交わる場合は、それらと交わらないようTh. lineを適宜設定する。そのTh. line
からCt値が得られるか否かを解析する。 
まず、2併行抽出したそれぞれのDNA試料液（各2ウェル）について、以下の結果の判定

スキームに従って判定する。 
 
各DNA試料液において、 
(1) コムギ陽性対照試験にて2ウェル並行すべてで43未満のCt値が得られ、かつ

MON71800検知試験にて2ウェル並行すべてで43未満のCt値が得られた場合、当該試料

は陽性と判定する。 
(2) コムギ陽性対照試験にて2ウェル並行すべてで43未満のCt値が得られ、かつ

MON71800検知試験にて2ウェル並行すべてで43未満のCt値が得られない場合、当該試

料は陰性と判定する。 
(3) コムギ陽性対照試験にて2ウェル並行すべてで43未満のCt値が得られ、かつ

MON71800検知試験にて2ウェル並行すべてで一致した結果が得られない場合は、再度、

検体からの「1. DNA抽出精製」以降の操作を行い、判定する。 
 
2併行抽出した両方のDNA試料液（合計4ウェル）において陽性と判定された検体を陽性

と判断し、少なくとも一方のDNA試料液において陰性と判定された検体を陰性と判断する。

(3)の場合、再抽出精製したDNA試料液においても陽性の判定が得られない場合には、

MON71800陰性と判定する。 
なお上記判定によりMON71800陽性が判定された結果についてmulticomponentを解析し、

目視でFAMまたはVICの蛍光強度の指数関数的な増加が観察でき、ROXの蛍光強度の明確
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な下降やFAMまたはVICの蛍光強度の緩やかな上昇がないことを確認する。また、コムギ

陽性対照試験にて少なくとも1ウェルで43未満のCt値が得られないDNA試料液については、

再度、検体からの「1. DNA抽出精製」以降の操作を行い、それでもコムギ陽性対照試験に

て少なくとも1ウェルで43未満のCt値が得られない場合には、本試料からの検知は不能とす

る。 
 
（図1略） 
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コメ（63Bt、NNBt、CpTI）の検査方法 
 
 
本検査法ではコメおよびコメ加工品（コメを主原料とするもので、コメ粉やビーフン等、

非加熱又は加工の程度の低いもの）を検査対象とし、DNA 抽出精製は、以下のイオン交換

樹脂タイプの DNA 抽出精製キット（QIAGEN Genomic-tip 100/G）を使用した DNA の抽出

精製法を用いる。別法としてシリカゲル膜タイプの DNA 抽出精製キット（NIPPON GENE 
GM quicker 2）を使用した DNA 抽出精製法をコメおよび非加熱加工品に適用できる。 

1 検体から 2 併行で DNA を抽出精製し、DNA 試料液を用いて定性リアルタイム PCR
法を実施する。 

 
 

1.～2.（略） 
 
3. 結果の解析と判定（図1参照） 
 
コメ陽性対照用試験および害虫抵抗性遺伝子組換えコメ検出用試験 3 試験の各試験の

いずれについても、結果の判定はAmplification plot上で指数関数的な増幅曲線とCt値の確認、

および、multicomponent上での対象色素由来の蛍光強度（FAM）の指数関数的な明確な増加

の確認をもって行う。害虫抵抗性遺伝子組換えコメ検出用試験 3 試験において目視で

Amplification plot上に指数関数的な増幅曲線が確認された場合には、害虫抵抗性遺伝子組換

えコメ陽性を疑う。次いで、ベースラインを（3 サイクルから15 サイクル）設定し、ΔRn
のノイズ幅の最大値の上側で、安定した指数関数的な増幅曲線上で交わるThreshold line 
（Th. line）として0.2に設定する。ただし、Th. lineがノイズや指数関数的でない増幅曲線と

交わる場合は、それらと交わらないようTh. lineを適宜設定する。 
 
2併行抽出より得られたDNA試料液（1抽出あたり2ウェル並行で測定）の合計4ウェルす

べてを用いて判定する。 
 
DNA試料液において、 
（１）コメ陽性対照用試験の2併行すべてのウェルで48未満のCt値が得られ、かつ害虫抵

抗性遺伝子組換えコメ検出用試験 3 試験のいずれかの試験において、すべてのウ

ェルで48未満のCt値が得られた場合に、当該試料は害虫抵抗性遺伝子組換えコメ

陽性と判定する。 
（２）コメ陽性対照用試験の2併行すべてのウェルで48未満のCt値が得られ、かつ害虫抵

抗性遺伝子組換えコメ検出用試験の3 試験のいずれかのすべての試験において、

すべてのウェルで48未満のCt値が得られない場合は、害虫抵抗性遺伝子組換えコ

メ陰性と判定する。 
（３）コメ陽性対照用試験の2併行すべてのウェルで48未満のCt値が得られ、かつ害虫抵

抗性遺伝子組換えコメ検出用試験 3試験のいずれかの試験においてすべてのウェ

ルの結果が一致しない場合は、粉砕・均質後の当該試料から改めて2 回目のDNA



 

 13

抽出精製を行い、さらに「2. 定性リアルタイムPCR法」以降の操作を実施して判

定を行う。2回目のDNA試料液を用いた場合でも陽性の判定が得られない場合に

は、害虫抵抗性遺伝子組換えコメ陰性と判定する。 
 
2併行抽出のそれぞれの抽出DNA試料液（各2ウェル）について、結果の判定スキームに

従って判定し、両方の抽出DNA試料液（合計4ウェル）について陽性と判定された検体を

陽性と判断する。 
 
 
 
 
 
 
 

なお上記判定により害虫抵抗性遺伝子組換えコメ陽性が判定された結果について

multicomponentを解析し、目視でFAMの蛍光強度の指数関数的な増加が観察でき、ROXの
蛍光強度の明確な降下やFAMの蛍光強度の緩やかな上昇がないことを確認する。また、コ

メ陽性対照用試験のすべてのウェルで48未満のCt値が得られないDNA試料については、再

度、粉砕・均質後の当該試料から改めて2回目のDNA抽出精製を行い、さらに「2. 定性リ

アルタイムPCR法」以降の操作を行い、それでもコメ陽性対照用試験のすべてのウェルで

48未満のCt値が得られない場合には、本試料からの検知は不能とする。 
 

ABI PRISMTM 7900または 7500以外のリアルタイム PCR機器として、ABI PRISMTM 7700、
7000 等が適用可能である。使用するリアルタイム PCR 機器によって感度が異なるので、標

準プラスミド DNA 溶液（下記参考）を用いて事前に PCR 用反応液の調製法、PCR 条件、

解析方法を最適化する。 
 
（参考） 
（１）イオン交換樹脂タイプの DNA 抽出精製キット（QIAGEN Genomic-tip）は、キアゲン（〒104-0054

東京都中央区勝どき 3-13-1 FOREFRONT TOWER II. Tel. 03-6890-7300 Fax. 03-5547-0818）から購入

可能である。シリカゲル膜タイプキット法（NIPPON GENE GM quicker 2 変法）の NIPPON GENE 
GM quicker 2 キットは、ニッポンジーン（〒930-0982 富山市問屋町 1-8-7. Tel.076-451-6548 Fax. 
076-451-6547）から購入可能である。 

 
（２）コメの検査法に用いるプライマー対、プローブ（CpTIコメ検出用プローブ（KDEL-P）を除く。）

およびリアルタイムPCR法用標準プラスミド（GMコメ害虫抵抗性コメ検査用陽性コントロールプ

ラスミド）は、ニッポンジーン（〒930-0834 富山市問屋町1-8-7. Tel. 076-451-6548 Fax. 076-451-6547）
又はファスマック（〒243-0041厚木市緑ヶ丘5-1-3. Tel. 046-295-8787 Fax. 046-294-3738）から購入可

能である。 
 

（３）コメの検査法に用いるプローブのうち、CpTIコメ検出用プローブ（KDEL-P）についてはライフ
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テクノロジーズ社（〒108-0023 港区芝浦4-2-8 住友不動産三田ツインビル東館 Tel. 03-6832-9300）
から購入可能である。 

 
（図 1 略） 
  



 

 15

トウモロコシ（Bt10）の検査方法（略） 
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トウモロコシ（CBH351）の検査方法（略） 
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トウモロコシ（DAS59132）の検査方法（略） 
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ナタネ（RT73 B. rapa）の検査方法（略） 
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パパイヤ（PRSV-YK、PRSV-SC、PRSV-HN）の検査方法（略） 
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ばれいしょ（F10、J3）の検査方法（略） 
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さけ（AquAdvantage）の検査方法 
 
 
本法では生さけ及びさけ加工食品を検査対象とし、DNAの抽出精製は、以下のシリカゲ

ル膜タイプキット（NIPPON GENE GM quicker 3）又はイオン交換樹脂タイプキット

（QIAGEN Genomic-tip 20/G）を用いる。GMさけAquAdvantageの検出は、AquAdvantage検
知用のプライマー、プローブを用いたリアルタイムPCRとさけ陽性対照用のプライマー、

プローブを用いたリアルタイムPCRの2試験を行い判定する。 
AquAdvantage検知用として、サケゲノム配列と北太平洋サケ（マスノスケ）由来の成長

ホルモン遺伝子プロモーター領域の境界領域を検知するよう設計したプライマー、プロー

ブを用いる。また、リアルタイムPCR反応陽性対照用としてさけ由来18S rRNA遺伝子配列

を検知するプライマー、プローブを用いる。 
1検体から2併行でDNAを抽出精製し、DNA試料液を得る。そのDNA試料液を用いて定性

リアルタイムPCR法を実施する。 
 
 
1. 生さけ及びさけ加工食品からのDNA抽出精製 

 
生さけ及びさけ加工食品は以下の3種類の製品に細分類し、以下に示したそれぞれの試料

前処理プロトコルに従ってDNA抽出精製前の試料調製を行う。 
 

①生さけ等（スモークサーモン、缶詰（水煮など）、さけフレークなど） 
②乾燥製品（ふりかけ、お茶漬けなど） 
③さけの卵（すじこ、いくら）及びその加工食品 
 
 
1.1. 試料前処理 
1.1.1. 生さけ等（スモークサーモン、缶詰（水煮など）、さけフレークなど） 

 
一包装分（又は多い場合は脂肪分を除いたさけの可食部 120 g）を採取し、等重量分の滅

菌蒸留水を加え、Millser 等で粉砕し、均質にした試料 1 g をポリプロピレン製遠沈管（50 mL
容）に量りとる。 

 
 

1.1.2. 乾燥製品（ふりかけ、お茶漬けなど） 
 
一包装分（又は 120 g）を採取し、Millser 等で粉砕し、均質にした試料 0.5 g をポリプロ

ピレン製遠沈管（50 mL 容）に量りとる。 
 
 

1.1.3. さけの卵（すじこ、いくら）及びその加工食品 
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卵 50 g を採取する。等重量分の滅菌蒸留水を加え、Millser 等で粉砕する。粉砕した試料

1 g をポリプロピレン製遠沈管（50 mL 容）に量りとる。 
 
 
1.2. 試料からの DNA の抽出精製 

 
DNA の抽出精製法は、前処理済検体に緩衝液の特段の吸収性のないもの（生さけ、スモ

ークサーモン、缶詰（水煮など）、さけフレークなど）については、1.2.1.1. シリカゲル膜

タイプキット（NIPPON GENE GM quicker 3）A 法、前処理済検体に緩衝液の吸収性のある

もの（乾燥製品（ふりかけ、お茶漬けなど）など）については、1.2.1.2. シリカゲル膜タイ

プキット（NIPPON GENE GM quicker 3）B 法、又は魚卵など油分の多い加工食品（すじこ、

いくらなど）については、1.2.1.3. イオン交換樹脂タイプの DNA 抽出精製キット（QIAGEN 
Genomic-tip 20/G）法を使用する。 
 
 
1.2.1. DNA の抽出精製 
1.2.1.1. シリカゲル膜タイプキット（NIPPON GENE GM quicker 3）A法 
（生さけ、スモークサーモン、缶詰（水煮など）、さけフレークなど、緩衝液の特段の吸収

性のないものに適用。） 
 
ポリプロピレン製遠沈管（50 mL容）に量りとったDNA抽出用試料に、GE1緩衝液*11 mL、

RNase A*1 10 L及びProteinase K*1 5 Lを加え、試料塊がないように試験管ミキサーで30秒
間以上混合した後*2、65℃で30分間加温する。その間、10分間毎に2回、試験管ミキサーで

10秒間激しく撹拌する。GE2-P緩衝液*1 200 Lを加え、試験管ミキサーでよく混合する。

4,000×g以上*3、4℃の条件で10分間遠心し、上清*4 800 Lを2.0 mL容チューブに移す。GB3
緩衝液*1 600 Lを添加した後、10～12回転倒混和する。12,000×g以上、4℃の条件で15分間

遠心し、上清を可能な限り採取する。その上清700 Lをspin columnに負荷し、10,000×g以
上、4℃の条件で30秒間遠心し、溶出液を捨てる。残りの混合液全量を同じspin columnに負

荷し、同条件で遠心し溶出液を捨てる。次いでGW緩衝液*1 600 Lを負荷し、10,000×g以上、

4℃の条件で1分間遠心し、溶出液を捨てる。spin columnを新たな1.5 mL容チューブに移し、

水50 Lを加え、3分間室温で静置した後、10,000×g以上で1分間遠心し、得られた溶出液を

DNA試料原液とする。 
 
*1 GE1緩衝液、GE2-P緩衝液、GB3緩衝液、GW緩衝液、RNase A、Proteinase Kはシリカゲル膜タイプの

キット（NIPPON GENE GM quicker）付属のもの又は同等の活性を有するものを用いる。 
*2 ボルテックスに対して50 mL容チューブを垂直にあて、そのまま30秒間しっかりと攪拌する。 
*3 使用するローター及び50 mL容チューブの特性を考慮したうえで、gが最大となるように遠心条件を設

定する。遠心機のローターはスウィング式、アングル式のどちらを用いてもよい。 
*4 沈殿や浮遊物等を可能な限り取らないように上清を回収する。 
 
 
1.2.1.2. シリカゲル膜タイプキット（NIPPON GENE GM quicker 3）B法 
（乾燥製品（ふりかけ、お茶漬けなど）など、緩衝液の吸収性のあるものに適用。） 
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ポリプロピレン製遠沈管（50 mL容）に量りとったDNA抽出用試料に、GE1緩衝液*1 2.25 
mL、RNase A*1 10 L及びProteinase K*1 5 Lを加え、試料塊がないように試験管ミキサーで

30秒間以上混合した後*2、65℃で30分間加温する。その間、10分間毎に2回、試験管ミキサ

ーで10秒間激しく撹拌する。GE2-P緩衝液*1 250 Lを加え、試験管ミキサーでよく混合する。

4,000×g以上*3、4℃の条件で10分間遠心し、上清*4 800 Lを2.0 mL容チューブに移す。GB3
緩衝液*1 600 Lを添加した後、10～12回転倒混和する。12,000×g以上、4℃の条件で15分間

遠心し、上清を可能な限り採取する。その上清700 Lをspin columnに負荷し、10,000×g以
上、4℃の条件で30秒間遠心し、溶出液を捨てる。残りの混合液全量を同じspin columnに負

荷し、同条件で遠心し溶出液を捨てる。次いでGW緩衝液*1 600 Lを負荷し、10,000×g以上、

4℃の条件で1分間遠心し、溶出液を捨てる。spin columnを新たな1.5 mL容チューブに移し、

水50 Lを加え、3分間室温で静置した後、10,000×g以上で1分間遠心し、得られた溶出液を

DNA試料原液とする。 
 
*1 GE1緩衝液、GE2-P緩衝液、GB3緩衝液、GW緩衝液、RNase A、Proteinase Kはシリカゲル膜タイプの

キット（NIPPON GENE GM quicker）付属のもの又は同等の活性を有するものを用いる。 
*2 攪拌操作が不十分であると、DNAの収量が減少する。ボルテックスに対して50 mL容チューブを垂直

にあて、そのまま30秒間しっかりと攪拌する。攪拌が不十分な場合はさらに30～60秒間攪拌する。 
*3 使用するローター及び50 mL容チューブの特性を考慮したうえで、gが最大となるように遠心条件を設

定する。遠心機のローターはスウィング式、アングル式のどちらを用いてもよい。 
*4 沈殿や浮遊物等を可能な限り取らないように上清を回収する。 
 
 
1.2.1.3. イオン交換樹脂タイプキット（QIAGEN Genomic-tip 20/G）法 
（すじこやいくらなど、油分の多い加工食品に適用。） 

 
ポリプロピレン製遠沈管（50 mL容）に量りとったDNA抽出用試料に、G2緩衝液＊18 mL、

Proteinase K＊250 LとRNase A＊2 10 Lを加えて、試験管ミキサー又は転倒混和により激し

く撹拌した後、50℃で1時間放置する。その間、2、3回遠沈管を反転させて試料を転倒混和

する。次いで、3,000×g以上で、低温下（4℃）15分間遠心*3し、得られた上清をポリプロ

ピレン製遠沈管（15 mL容）に移し、さらに、3,000×g以上で、低温下（4℃）5分間遠心す

る。次いで、得られた上清は、QBT緩衝液＊11 mLを用い平衡化したQIAGEN Genomic-tip 20/G
に2 mLずつ数回に分けて負荷する＊4。次いで、QIAGEN Genomic-tip 20/GはQC緩衝液＊1で2 
mLずつ3回洗浄した後、新しい遠沈管に移す。予め50℃に温めておいたQF緩衝液＊1を1 mL
ずつ2回加え、DNAを溶出する。溶出液は、高速遠心に耐えられる遠沈管に移し、等量の

イソプロピルアルコールを加えよく混合し、10,000×g以上で、低温下（4℃）、15分間遠心

し、上清を捨てる。70% （v/v） エタノール1 mLを加え、さらに10,000×g以上で、低温下

（4℃）5分間遠心する。上清は捨て＊5、沈殿物を乾燥させた後、50℃に温めた滅菌水50 L
を加え、ピペッティングによりDNAを溶解させ、DNA試料原液とする。 
 
＊1 G2緩衝液、QBT緩衝液、QC緩衝液、QF緩衝液はキアゲン社Genomic DNA Buffer Set（Cat. No. 19060）

に付属しているが、足りない場合には単品で購入するかキットの説明書に従って調製可能である。 
＊2 キットに付属のもの又は同等の効力を持つものを用いる。 
＊3 遠心機のローターはスウィング式、アングル式のどちらを用いてもよい。 

＊4 浮遊物は出来るだけ負荷しないようにする。 
＊5 沈殿物が見えない場合でも、遠沈管内の底部付近にはできるだけ触れないように、上清を完全に除去

する。 
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1.2.2 DNA 試料原液中の DNA の純度の確認並びに DNA 試料液の調製と保存 

 
DNA 試料原液の適当量を取り、滅菌蒸留水を用いて適宜希釈し*1、200～320 nm の範囲

で紫外部吸収スペクトルを測定し、260 及び 280 nm の吸光度（A260及び A280
*2）を記録す

る。次いで A260の値 1.0 を 50 ng/ L DNA として DNA 濃度を算出する。また、A260/A280を

計算し、この比が 1.7～2.0 になれば、DNA が十分に精製されていることを示す*3。得られ

た DNA 濃度から、滅菌蒸留水で DNA 試料原液を 10 ng/ L に希釈して調製し、DNA 試料

液とする。DNA 試料液は 25 L ずつマイクロ遠沈管に分注し、-20°C 以下で冷凍保存する。

分注した DNA 試料液は、融解後直ちに使用し、残った溶液は再度保存せず廃棄する。な

お、DNA 試料原液の濃度がリアルタイム PCR で規定された濃度に達しないときは、その

まま DNA 試料液として用いる。 
 

*1 希釈倍率は、吸光度測定装置により適切な測定に要する液量及び濃度域が異なるため、適宜とする。 
*2 A260が DNA 由来の吸光度、A280がタンパク質等不純物由来の吸光度と考える。 
*3 A260/A280の比が1.7～2.0の範囲外であっても精製等の更なる操作は要さない。 
 
 
2. 定性リアルタイムPCR法 

 
AquAdvantageの検出は、AquAdvantage検知用のプライマー、プローブを用いたリアルタ

イムPCRとリアルタイムPCR反応陽性対照用のプライマー、プローブを用いたリアルタイ

ムPCRの2試験を行い判定する。各プライマー、プローブは滅菌蒸留水に溶解する。プライ

マー、プローブの塩基配列は以下のとおりである。 
 

・AquAdvantage検知用プライマー対、プローブ 
AquAd-F: 5’-TGCTGATGCCTCTGATACCAC-3’ 
AquAd-R: 5’-ATGCCTCTAGTGCAAGTTCAGTC-3’ 
AquAd-P: 5’-FAM- CAGTAGTACAACGTTGGCAGATGTATGAGAACT-BHQ1-3’ 

 
・リアルタイムPCR反応陽性対照用プライマー対、プローブ 

18S F: 5’- TGT GCC GCT AGA GGT GAA ATT -3’ 
18S R: 5’-GCA AAT GCT TTC GCT TTC G -3’ 
18S P: 5’-FAM- TTG GAC CGG CGC AAG ACG G-TAMRA-3’ 

 
2.1. PCR用反応液の調製 

 
リアルタイムPCR用反応液は25 μL/well として調製する*1。組成は以下のとおりである。

FastStart Universal Probe Master （Rox）*2、対象プライマー対溶液（各プライマー、50 μmol/L）
各 0.4 μL、対象プローブ溶液（10 μmol/L）0.25 μLを混合し、滅菌蒸留水で全量 20 μL に
調製後、10 ng/μL DNA試料液 5 μL（50 ng）を添加する。PCRのブランク反応液*3として、
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必ずDNA試料液を加えないものについても同時に調製する。各DNA試料液あたり

AquAdvantage検知用とリアルタイムPCR反応陽性対照用のリアルタイムPCRをそれぞれ2 
ウェル併行して行うものとする。分注操作終了後、真上からシール*4 し、完全にウェルを

密閉する（チューブの場合は専用キャップをする。）。このとき、しわが寄らないよう注

意し、専用のシーリング用アプリケーター*4を用いて行う。ABI PRISMの場合は、最後にウ

ェルの底を観察し、底に気泡がある場合は、プレートの縁を軽く叩いて気泡を抜いておく。

プレート遠心機で反応液をスピンダウン（目安：1,500g、2分間）する。ABI PRISM 7900HT
の場合は、MicroAmp Optical Cover Compression Pad*5 を茶色の面が上になるよう、プレート

の上面にセットする。 
 
*1 ABI PRISM 7900HT又はABI 7500を使用する場合は、MicroAmp Optical 96-Well Reaction Plate（Thermo 

Fisher Scientific社）を、LightCycler 96又は480を使用する場合は、LightCycler®480 Multiwell Plate 96又
はLightCycler 8-Tube Strips（white）（LightCycler 480の場合は、LightCycler 8-Tube Strip Adapter Plate
を用いる。）（ロシュ・ダイアグノスティックス社）を用いる。 

*2 FastStart Universal Probe Master （Rox） （ロシュ・ダイアグノスティックス社）を含む溶液は粘性が

高いため、混合操作及び採取を行う際には注意が必要である。混合操作を行う際には、混合が確実に

行われるように注意する。不十分な場合には、PCRがうまくいかない場合がある。使う直前には必ず

軽く攪拌後、遠心し、溶液を試料管の底に集めておいてから使用する。また、ウェルに分注する際は、

以後撹拌、遠心が困難なことを考慮し、ウェルの底に確実に入れる。 
*3 Non-Template Control（NTC） 

DNA 試料液の添加の際、NTC にはDNA 試料液の代わりに水をウェルに5 μL添加する。 
*4 シール及びシーリング用アプリケーター 

ABI PRISM 7900HT又はABI 7500の場合は、ABI PRISM Optical Adhesive Cover（Thermo Fisher Scientific
社）を使用する。LightCycler 96又は480の場合は、LightCycler® 480 Sealing Foil（ロシュ・ダイアグノ

スティックス社）を使用する。シーリングの詳細については製品付属のマニュアルを参考のこと。 
*5 MicroAmp Optical Cover Compression Pad（Thermo Fisher Scientific社） 

ABI PRISM 7900HTの場合のみ使用する。ABI PRISM 7500やLightCycler 96又は480では使用しない。 
 
 
2.2. リアルタイムPCRによる測定 
（ABI PRISM 7900HTの他、同等の性能を持つABI 7500、LightCycler 96又はLightCycler 480
を使用する。） 
2.2.1. ABI PRISM 7900HT  
① オペレーション用 PC の電源を入れ、起動させる。PC が完全に起動してから ABI 

PRISM 7900HT 本体の電源を入れ、30 分以上ウォーミングアップしたのちに反応を

開始する。 
② デスクトップ上のアプリケーション [ABI PRISM 7900 SDS Software] をダブルクリ

ックして開く。メニューバーの [File] → [New] を選択し、{New Document} ダイア

ログを表示させる。{Assay} は [Absolute Quantification (Standard Curve)]、{Container} 
は [96 Wells Clear Plate]、{Template} は [Blank Template] を選択し、[OK] ボタンを

クリックする。 
③ メニューバーの [Tools] → [Detector Manager] を選択し、{Detector Manager} ダイア

ログを表示させる。[New] ボタンをクリックし、{Add Detector} ダイアログを開く。
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Detector の設定は、AquAdvantage 検知試験は Reporter を [FAM]、Quencher を [BHQ]
とし、リアルタイム PCR 反応陽性対照試験は Reporter を  [FAM]、Quencher を 
[TAMRA]として[OK] ボタンをクリックする。{Detector Manager} ダイアログ上で使

用する Detector（リアルタイム PCR 反応陽性対照試験、AquAdvantage 検知試験）を

選択し、[Copy To Plate Document] ボタンをクリックし、[Set Up] タブ上に使用する

Detector を登録し、最後に [Done] ボタンをクリックする。 
④ 画面左上枠でリアルタイム PCR 反応陽性対照試験又は AquAdvantage 検知試験のウ

ェルを選択し、右枠の [Set Up] タブ上で、Detector が [リアルタイム PCR 反応陽性

対照試験]又は [AquAdvantage 検知試験] の行の {Use} 欄にチェックを入れる。次に

ウェルごとに {Task} 欄でそれぞれの情報（Non-Template Control：NTC、測定対象検

体：Unknown）を選択し、{Sample Name} フィールドにサンプル番号を入力する。

{Passive Reference} が [ROX] に設定されていることを確認する。 
⑤ [Instrument] タブ上の [Thermal Profile] よりサーマルサイクラー条件を以下のよう

に設定する。[50℃, 2 分 → 95℃, 10 分 → (95℃, 15 秒 → 57℃, 1 分) ×45 サイクル] 
⑥ {Sample Volume} を[25 L] に設定し、{9600 emulation モード} にチェックが入って

いることを確認する。 
⑦ 設定条件をプレートドキュメント（.sds）として保存する。 
⑧ [Instrument] タブ上の [Connect] ボタンをクリックし、PC と ABI PRISM 7900HT 本

体を connect 状態にする。[Instrument] タブ上の [Open / Close] ボタンをクリックし、

ステージを装置本体から出し、2.1.で調製した 96 ウェルプレートを切欠き部を右上

にしてステージ上に載せる。再び [Open / Close] ボタンをクリックし、96 ウェルプ

レートを装置本体にセットする。 
⑨ [Instrument] タブ上の [Start] ボタンをクリックし、反応とデータの取り込み（所要

時間：約 2 時間）を開始する。 
 
 
2.2.2. ABI 7500  
① オペレーション用 PC の電源を入れ、起動させる。PC が完全に起動してから ABI7500

本体の電源を入れ、30 分以上ウォーミングアップしたのちに反応を開始する。 
② デスクトップ上のアプリケーション [7500 System Software] をダブルクリックして

開く。メニューバーの [File] → [New] を選択し、{New Document} ダイアログを表

示させる。{Assay} は [Absolute Quantification (Standard Curve)]、{Container} は [96 
Wells Clear]、{Template} は [Blank Template] 、{Run Mode} は [9600 emulation]を選

択し、[NEXT] ボタンをクリックする。 
③ Detectorの設定は、AquAdvantage 検知試験は Reporter を [FAM]、Quencherを [BHQ]

とし、リアルタイム PCR 反応陽性対照試験は Reporter を  [FAM]、Quencher を 
[TAMRA]として、[ADD] ボタンをクリックする。{Passive Reference} が [ROX] に
設定されていることを確認し、[NEXT] ボタンをクリックする。 

④ 画面下枠でリアルタイム PCR 反応陽性対照試験又は AquAdvantage 検知試験のウェ

ルを選択し、上枠で、Detectorが [さけ陽性対照試験] 又は [AquAdvantage 検知試験] 
の行の {Use} 欄にチェックを入れる。次にウェルごとに {Task} 欄でそれぞれの情

報（Non-Template Control：NTC、測定対象検体：Unknown）を選択し、[FINISH] ボ
タンをクリックする。 

⑤ [Setup] タブ上の各ウェルをダブルクリックし、サンプル名を入力する。 
⑥ [Instrument] タブ上の [Thermal Cycle Protocol] よりサーマルサイクラー条件を以下
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のように設定する。[50℃, 2 分 → 95℃, 10 分 → (95℃, 15 秒 → 57℃, 1 分) ×45 サイ

クル] 
⑦ {Sample Volume} を[25 L] に設定する。 
⑧ 設定条件をプレートドキュメント（.sds）として保存する。 
⑨ 2.1. で調製した 96 ウェルプレートを切欠き部を右上にして、装置本体のステージ上

に載せセットする。 
⑩ [Instrument] タブ上の [Start] ボタンをクリックし、反応とデータの取り込み（所要

時間：約 2 時間）を開始する。 
 
 
2.2.3. LightCycler 96  
① LightCycler 96 本体の電源を入れ、セルフテストが完了して起動するまで約 5 分待機

する。 
② LightCycler 96 本体タッチパネル上の[New] をタッチし{Create New Experiment}を表

示させる。 [Roche template]から [RunTemplate_HydrolysisProbes_Amp]を選択し、

{Experiment Name}を設定し[Create]する。 
③ [Run Editor] タブの[Measurement]で、{Reaction Volume( l)} を[25 L] に設定する。 
④ [Run Editor] タブの[Profile]でサーマルサイクラー条件を[95℃, 10 分 → (95℃, 15 秒 

→ 57℃, 1 分) ×45 サイクル]のように設定する。57℃の Step の Acquisition .Mode が
[Single]となっていることを確認する。 

⑤ [Eject]をタッチしてブロックを引出し、2.1. で調製した 96 ウェルプレートを切欠き

部を右下にして、サーマルブロック上に載せセットして閉じる。 
⑥ [Start] をタッチし、反応とデータの取り込みを開始する。 
⑦ 反応の終わったファイルを LC96 Application Software で開く。 
⑧ [Sample Editor]タブ画面のウェルフォーマット図でリアルタイム PCR 反応陽性対照

試験又は AquAdvantage 検知試験のウェルを選択し、Gene の{FAM}欄に該当する遺

伝子名を入力する（一度入力すると、プルダウンから選択する事が出来る。）。次に

ウェルごとに Sample の{Type} 欄でそれぞれの情報（Negative Control、測定対象検

体：Unknown）を選択する。 
⑨ ウェルフォーマット図の各ウェルをクリックし、Sample の{Name}欄にサンプル名を

入力する（一度入力すると、プルダウンから選択する事が出来る。）。 
 
 
2.2.4. LightCycler 480  
① LightCycler 480 本体の電源を入れ、セルフテストが完了して起動するまで約 5 分待

機する。オペレーション用 PC の電源を入れ、起動させる。 
② デスクトップ上のアプリケーション  [LightCycler480 SW] をダブルクリックし、

[User Name]と[Password]を入力してソフトを立ち上げる。 
③  [New Experiment from Template] をクリックし{Create Experiment from Template}か

ら [Mono color HydrolysisProbe-UPL]を選択し、OK する。 
④ [Run Protocol] タブで、{Reaction Volume} を[25] に設定し、サーマルサイクラー条

件を次のように設定する [95℃, 10 分 → (95℃, 15 秒 → 57℃, 1 分「Single」) ×45 サ

イクル→40℃,30 秒]。 57℃の Step の Acquisition Mode が[Single]となっていることを

確認する。 
⑤ Save をクリックし設定条件を保存する。 
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⑥ 本体のプレートローディングボタンを押してプレートローダー出し、2.1. で調製し

た 96 ウェルプレートを切欠き部を右下にしてセットした後、再度ボタンを押してプ

レートローダーを格納する。 
⑦ [Start Run] をクリックし、反応とデータの取り込みを開始する。 
⑧ （反応中に）[Subset Editor]にて、（+）ボタンから New Subset を作成し、サンプルを

セットしたウェルを選択した後 Apply をクリックする。 
⑨ [Sample Editor]にて、Step1:[Select Workflow]で Abs Quant を選択する。Step2:[Select 

Samples]の[Subset]プルダウンから⑧で作成した Subset を選択する。Step3:[Edit Abs 
Quant Properties]で、各ウェルを選択し、[Sample Name]を入力し、{Sample Type} 欄
でそれぞれの情報（Negative Control、測定対象検体：Unknown）を選択する。 

 
 
3. 結果の解析と判定（図 1参照） 

 
リアルタイムPCR反応陽性対照試験とAquAdvantage検知試験のいずれについても、結果

の判定はAmplification plot上で指数関数的な増幅曲線とCt（Cq）値の確認及び対照色素由来

の蛍光強度（FAM）の指数関数的な明確な増加の確認をもって行う。 
 
ABI PRISM 7900HT又はABI 7500を使用した場合のデータの解析 
① メニューバーの [Analysis] → [Analyze] を選択する。 
② 画面右枠の [Result] タブをクリックして {Amplification Plot} 画面を表示させる。 
③ {Amplification Plot} 画面上の {Plot} 欄で [ΔRn vs Cycle] を表示させ、{Threshold} 

欄に [0.2] と入力する。 
④ {Amplification Plot} 画面上の {Detector} 欄で [All] を選択する。表中に Ct 値が表

示される。 
 

LightCycler 96を使用した場合のデータの解析 
① [Analysis]タブをクリックし[Add Analysis] を選択し{Create New Analysis}を表示させ

る。[Abs Quant]を選択し[OK]をクリックする。 
② [Amplification Curves]に増幅曲線が、[Result Table] に Cq 値が表示される。 

 
LightCycler480を使用した場合のデータの解析 
① [Analysis]ボタンをクリックし{Create new analysis}にて、[Abs Quant/2nd Derivative 

Max]を選択し[Subset]プルダウンから 2.2.4⑧で作成した Subset を選択し [OK]をクリ

ックする。 
② 表示された画面で、[Calculate]をクリックする。 
③ 増幅曲線と、[Result Table] に Cq 値が表示される。 

 
2併行抽出より得られたDNA試料液（1抽出あたり2ウェル併行で測定。）の合計4ウェル

すべてを用いて判定する。 
 
DNA試料液において、 
（１）リアルタイムPCR反応陽性対照試験の2併行すべてのウェルで43未満のCt（Cq）値

が得られ、かつAquAdvantage検知用試験のすべてのウェルで43未満のCt（Cq）値

が得られた場合、当該試料は陽性と判定する。 
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（２）リアルタイムPCR反応陽性対照試験の2併行すべてのウェルで43未満のCt（Cq）値

が得られ、かつAquAdvantage検知用試験のすべてのウェルにおいて43未満のCt
（Cq）値が得られない場合は陰性と判定する。 

（３）AquAdvantage検知用試験において、すべてのウェルで一致した結果が得られなか

った場合は、粉砕・均質後の当該試料から改めて2 回目のDNA抽出精製を行い、

さらに「2. 定性リアルタイムPCR法」以降の操作を実施して、判定を行う。2回目

のDNA試料液を用いた場合でも陽性の判定が得られない場合には、AquAdvantage
陰性と判定する。 

 
2併行抽出のそれぞれの抽出DNA試料液（各2ウェル）について、結果の判定スキームに

従って判定し、両方の抽出DNA試料液（合計4ウェル）について陽性と判定された検体を

陽性と判断する。 
 
なお、ABI PRISM 7900HT又はABI 7500を使用した場合は、上記判定によりAquAdvantage

陽性が判定された結果についてmulticomponentを解析し、目視でFAMの蛍光強度の指数関

数的な増加が観察でき、ROXの蛍光強度の明確な下降やFAMの蛍光強度の緩やかな上昇が

ないことを確認する。 
また、リアルタイム PCR 反応陽性対照用試験で 2ウェル併行の両方で 43 未満の Ct（Cq）

値が得られない DNA 試料液については、再度、検体からの「1.2. 試料からの DNA の抽出

精製」以降の操作を行い、それでも 2 ウェル併行の両方で 43 未満の Ct（Cq）値が得られ

ない場合には、本試料からの検知は不能とする。 
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Ⅲ．検査方法の同等性確認方法（略） 
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